iMovie ‘1 1 Tutorial



iMovie | | is consumer-level digital video editing software for Macintosh.You can use iMovie || to
edit the footage you film with digital video cameras and HD video cameras.The sections below will
help you use iMovie | | to edit your video efficiently. If you are unfamiliar with iMovie | | you may
want to have a look at an overview of the iMovie | | screen, to learn some of the menus and but-
tons.

0 I. Getting Started Pg. 2
02. Creating a new iMovie | | Project Pg. 3
03. Importing Video Clips into iMovie | | Pg. 4
04. Previewing your movie Pg. 5
05.Adding Clips to Your Project Pg. 6
06. Clip Adjustments Pg. 7-8
07.Adding Media Pg. 9
08.Adding Titles Pg. 9
09.Adding Transitions Pg. 9
10. Adding Animation Pg. 9
I 1. Sharing Your Video Pg. 10

12. Saving your Project Pg. 11-13



Below is a view of what your screen will look like when you open iMovie.The numbers correlate
with a short description of each feature on the screen.

e 00 iMovie

Proict Ligrary Project - My First Project

Drag media here to create a new project

To add video to your library:
Connect a video camera or choose an Import option from the File menu.

16

ol. - where all movie projects on computer are displayed

02. - shows current position in clip and is used for editing

03. - views clips or your final iMovie project

04. - can play selected movie project either in viewer or full screen

05. - allows you to start a new movie project

06. - allows you to see thumbnails of clips by amount of frames per thumbnail within
(the same feature is available in the window)

07. - where you import footage from your webcam or video camera

08. - swaps the Source Video and the iMovie Project from top to bottom

09. size of thumbnails used in iMovie

10. - where all the events (groups of clips) on computer are displayed

. - allows you to add clips to your project

12. - allows you to select favorite clips, or parts of clips, or just remove clips all together.

13. - this is where you can work on voice overs, cropping images, to adjust audio, or adjust
video

14. Turns on/off

I5. - different editing browsers such as adding music, photos, text, transitions, and

animations

16. - shows all events from a particular source that can be used for editing



To open a new project :
|.Open the Applications folder
2. Click on the iMovie icon (Figure I).
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Figure I.

3. When the iMovie | | screen appears, click New Project, or you can access other projects by clicking

on them in the Project Library located by clicking the Project Library Tab in the top left corner of the
iMovie window (Figure 2a). The New Project button is the button designated with a plus sign in the lower
right hand corner of the Project Library window (Figure 2b)

4. Click on the Plus sign button to create a new movie project.

Project Library

Figure 2a Figure 2b
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5.You will name your project and then select the Aspect Ratio for your project, either 4:3 fullscreen* or
16:9 widescreen*. Note: fullscreen footage is shaped more like a square; widescreen footage is shaped
more a like a rectangle (often with black bars at the top and bottom of the screen). You also have the
option to select what type of project you will be working on. iMovie || now allows for the creation of
Movie Trailers using specified templates which can be selected from the New Project menu. If you want
to create a normal movie project you may select a Theme at this time as well. A frame rate drop down
menu is also available to select different choices. For playback in the United States you should leave the
default of 30 fps - NTSC selected. There also is a check box and drop down menu which will allow you
to apply transitions to every clip within a project. By checking the Automatically Add: check box you
may specify a transition using the drop down menu.
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Figure 2c



Before you can edit your footage you must import it into the computer.

To start importing footage, do the following:
I. Click on the Camera Mode icon to make sure iMovie | | is in Camera Mode (Figure 3).
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Figure 3.
2. Depending on the type of camera being used the display will vary slightly. When using a mini DV camera
the Camera Mode will need to play through selected clips in real-time to capture (Figure 4a). Flash
memory cameras have a different window interface (Figure 4b) which displays whole clips as they were
captured in camera. Since the flash memory camera writes these videos to files directly, real-time capture
is not necessary.
3. Set the switch on the left to Automatic if you want iMovie to log the clips for you.
4.To manually capture using a mini DV camera, click the Capture button to start importing and stop
to end that particular clip.You can use the VCR controls on the camera to move the tape to where you
would like to import it. To manually capture using a flash memory camera, click the check box below each
clip that you wish to import and select Done.
5.When you capture/import your clips, it will ask you to add the clips to an existing event, or to create
a new event You will also have an opportunity to select whether you would like iMovie to apply image
stabilization, search for people within clips or both by using the drop down menu next to the check box
labeled After Import Analyze for. If you would like to use this feature, be sure you check the check
box and select what option you would like iMovie to apply it to your video. (Figure 5).
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Save to: Macintosh HD (469.7GB free / 108 hours... '3 ]

eAdd to existing Event: | New Event 6-1-11 e ]

() Create new Event: MNew Event 6-1-111

ol Split days into new Events

[ After import analyze for: | Stabilization s ]

Selecting this option will analyze all clips for stabilization, but
will result in longer import times.

| Cancel | [ Capture

Figure 5.
6.When you have reached the end of your footage, click the Done button to stop importing. 4.



During any part of the editing process, you may want to preview your movie.To preview your movie you
can choose one of the following:

I. Click Play under the Project Library to preview the entire movie (Figure 6).
OR
Click on the Star Icon to open the clip menu. Select Clip Trimmer (Figure 7), which brings it to Trim
mode, and you may preview the individual clip by clicking the Play icon, which is also located under the
Project Library.

Precision Editor

Clip Trimmer

Clip Adjustments
Video Adjustments

Audio Adjustments
Cropping & Rotation

Figure 7.

2.Your movie will play back in the Monitor Window (Figure 8)
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Figure 8.



To add clips to your movie:

I. Click on any of the clips within the Event Browser. A yellow box will appear on the thumbnail; adjust
the edges of the box so that all of the footage you want to add to your project is within the yellow box.
After you have done this, your mouse pointer will appear as a Hand.

2. Grab the thumbnail within the yellow box and drag it to the Project Browser to add it to your movie
(Figure 9).

3.The Clip Adjustment Bar (Figure 10) alters how many frames of each clip appear as a thumbnail.
Adjusting this can make selecting larger or smaller portions of clips easier.

Figure 10.

To reposition clips in your movie after you have added them:
|. Click and drag them to a new position, which is apparent when you see a bold green line appearing
when you try and reposition your clip.

You also have the option to split clips into pieces.

|. Click on the clip you would like to split and use the yellow box to select the portions of the clip that
you would like to separate.

2.Then click Split Clip in the edit menu.

To remove clips from your iMovie | | project:
|. Select a clip you wish to get rid of and press Delete.



Once you have placed a clip into your project.You have a variety of options for adjusting the clip. These
options include: Trim, Crop, Adjust Audio, AdjustVideo, and Voice Over.

To Trim a clip: click the Sun Icon that appears when you hover your mouse over a clip in your project

(Figure 11). Select Clip Trimmer.

Precision Editor
Clip Trimmer

Clip Adjustments
Video Adjustments
Audio Adjustments
Cropping & Rotation ]

Figure | 1.
Just like when inserting a clip, just drag the sides of the yellow box to manipulate what portion of the

video is included in your project (Figure 12). Press the Play button to preview your clip; press done
when finished.

Trim Clip

Figure 12.

To Crop a clip: click on the Cropping icon in the thumbnail of any clip, or clip on the cropping icon in
the Options Tab (Figure 13) and then clicking on the clip you'd like to crop.
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Figure 13.




You can then resize the green box (Figure 14) that appears on the clip to control how much of the
footage will be visible.

Figure 14 .

To Adjust Audio in a clip:

I. Click on the Sun Icon in the thumbnail of the clip (Refer back to figure | 1) and then select Audio
Adjustments from the menu.

2.You can adjust the audio of the clip, add an audio fade-in or fade-out, or apply ducking—which makes
other sounds, such as music,“duck” below the volume of your clip.

To AdjustVideo in a clip:
I. Click on the Sun lcon located in the bottom left corner of the thumbnail of any clip and select Video
Adjustments (refer to Figure 11).

This will allow you adjust the following:

Exposure — shadows and highlights

Brightness — overall light levels

Contrast — difference between white a black

Saturation — color intensity

White Point — changes color range by resetting the color white

To add Voice Over to any clip:

I. Click the Microphone Icon on far left of the Options Tab (Figure 13). You have the options to select
which microphone you would like to use, control the level at which your voice records, apply noise-
reducing vocal enhancement, and play your projects audio while you record.

2.When you are ready to record click on the clip you would like to record a voice over for.

3.After a three second countdown just begin talking as your video plays.



iMovie | | gives you the option of adding sound files or images to your project.To add a sound file:
I. Click the Music Note icon in the Edit Browser (Figure 15).

2. Browse for the sound file that you would like to add and drag it into your project.

To add an image file, click the Camera Icon in the Edit Browser, browse for the film, and then drag it
into your project.

Na| T HAQ@
Figure 15.

To add titles to a clip, click the “T”” icon on the Edit Browser (Refer back to figure 15). Once you have
selected the type of Title you would like to add, just drag the title on top of the clip you would like to add
it to. Then click within the thumbnail of the clip to alter the titles to suit your video.

Note:You can adjust the font of the titles by clicking the Show Fonts button at the top of the preview
window.

To add transitions to your project click the Transition Icon on right of the Edit Browser (Figure |5a).
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Figure |5a. n

Then drag the type of transition you would like to the place in the time line that you choose.

To add animations to your project, click the Animations Icon on far right of the Edit Browser

(Figure 15b).
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Figure |15b.

Then take the animation of your choice, click and drag it into the time line in the appropriate area.




After you have made the finishing touches to your video it is time to share it with the world. iMovie | |

gives you a number of different options for exporting your video.

Under the Share tab (Figure 16), you can choose from the following:

Media Browser — this option exports your video to the media browser to be used with other programs

like iVWWeb

iTunes — this sends your video straight to your iTunes library

iDVD — this allows you to export your movie into iDVD, which is DVD creation software that allows
users to create menus and burn their project to a DVD for playback on DVD players

MobileMe Gallery — this allows users that have a MobileMe account to upload photos and videos to
the web

YouTube — this option allows you to upload your video directly to YouTube

Facebool« — this option allows you to upload your video directly to Facebook

Vimeo — this option allows you to upload your video directly to Vimeo

CNN iReport — this option allows you to upload your video directly to CNN iReport

Podcast Producer — exports video to Podcast Producer for the creation of podcasts

Export Movie — this is the most commonly used option, you can choose the size of your video file in
order to optimize its performance

Export using Quicktime — this is an advanced option that allows for the greatest control of export
Export Final Cut XML — this option exports a file that can work within Final Cut Pro

Remove from — allows users to remove uploaded the project from selected online accounts such as
Facebook, Youtube and Vimeo

m Window Help

Media Browser...
iTunes...
iDVD...

MobileMe Gallery...
YouTube...
Facebook...
Vimeo...

CNN iReport...
Podcast Producer...

Export Movie... $HE
Export using QuickTime...
Export Final Cut XML...

Remove from >
Figure 16



Saving in iMovie | | is similar to iMovie 09. You are no longer required to continually save your project
to avoid data loss. The program automatically saves your project to the computers hard drive as you are
working.

When you are finished with your project and plan to work on it at a later point you will first need to
make sure that you have a large enough storage device to save your project to. Usually it is safe to acquire
one that has at least 20 GB of available space.

Saving from a campus computer:
| Plug you hard drive in the firewire port in the back or on the side of the computer.

2 Make sure that you are able to see the symbol that shows your hard drive has been recognized by the
computer.
3 Next, click on the hard drive (Figure 17) of the computer that you are working on.

Macintosh HD
Figure 17.
4 Click on the Users folder (Figure 18).

> & Users

Figure 18.

5 Click on Your Username (Figure 19).

> % fralcon
Figure 19.

6 Click on the Movies Folder (Figure 20).

> Movies

Figure 20.

7 Here you should see two folders. One will be named iMovie Projects and the other will be
named iMovie Events (Figure 21).

» [ ] iMovie Projects
» [ ] iMovie Events
Figure 21.

Note:You need both of these folders in order for your project to properly save.



8 Select both folders by clicking on one, holding down Shift and selecting the other (Figure 22).

> B iMovie Projects

P ™ iMovie Events
Figure 22.

9 When both folders are highlighted click and drag them over the symbol that represents your external
hard drive/storage device (Refer back to figure 17).

10 You should see a plus symbol, which lets you know that it is alright to add these files to your drive.
I'l Allow the computer enough time to save the folders and then you are able to eject your desk and
work on your project at a later time.

Saving from your personal computer:
| Plug you hard drive in the fire wire port in the back or on the side of the computer.

2 Make sure that you are able to see the symbol that shows your hard drive has been recognized by the

computer.
3 Click Go on the Finder Menu Bar. (Figure 23)

Go
Figure 23.

4 Click the Home option from the drop down menu (Figure 24).
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Desktop {%D
Figure 24.

5 Click on the Movies folder (Figure 25).
B Maovies
Figure 25.

6 Here you will see two folders. One will be named iMovie Projects and the other will be named
iMovie Events (Figure 26).

» [ iMovie Projects
» [ ] iMovie Events
Figure 26.



7 Select both folders by clicking on one and hold down Shift and selecting the other (Figure 27).

> B iMovie Projects

> B iMovie Events

Figure 27.

8 When both folders are highlighted click and drag them over the symbol that represents your external
hard drive/storage device.

9 You should see a plus symbol, which lets you know that it is alright to add these files to your drive.

10 Allow the computer enough time to save the folders and then you are able to eject your desk and
work on your project at a later time.



